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DisplayPort Automated Testing—At A Glance

The Agilent U7232A DisplayPort Electrical Performance Compliance Test
Application helps you verify DisplayPort Source device under test (DUT)
compliance to DisplayPort specifications using an Agilent 8 GHz or greater
Infiniium digital storage oscilloscope. The DisplayPort Electrical
Performance Compliance Test Application:

e Lets you select individual or multiple tests to run.
e Lets you identify the device being tested and its configuration.

* Shows you how to make oscilloscope connections to the device under
test.

* Automatically checks for proper oscilloscope configuration.
¢ Automatically sets up the oscilloscope for each test.

¢ Provides detailed information for each test that has been run and lets
you specify the thresholds at which marginal or critical warnings
appear.

* Creates a printable HTML report of the tests that have been run.

The tests performed by the DisplayPort Electrical Performance Compliance Test Application
are intended to provide a quick check of the electrical health of the DUT. This testing is not
a replacement for an exhaustive test validation plan.

Compliance testing measurements are described in Section 3, Source
Compliance Tests, in the DisplayPort- Compliance Test Specification
Version 1 document. For more information, see the VESA web site at

WWWw.vesa.org.

Required Equipment and Software

In order to run the DisplayPort automated tests, you need the following
equipment and software:

e 8 GHz or greater Infiniium Oscilloscope. Option 001 (1 M/ch memory
upgrade) is recommended; this will greatly reduce Data Eye Pattern and
Jitter test time.

e U7232A DisplayPort Electrical Performance Compliance Test
Application.

e Keyboard, qty = 1, (provided with the Agilent Infiniium oscilloscope).
e Mouse, qty = 1, (provided with the Agilent Infiniium oscilloscope).

¢ Precision 3.5 mm BNC to SMA male adapter, Agilent p/n 54855-67604,
qty = 2 (provided with the Agilent Infiniium oscilloscope).

e Calibration cable (provided with the Infiniium oscilloscopes). Use a
good quality 50 Q BNC cable for calibrating the oscilloscope.

e E2655A/B probe de-skew fixture.
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1168A or 1169A Probes
Test fixture (W2641A). Includes four SMA to SMP cables.

U7232A DisplayPort Electrical Performance Compliance Test Application
license.

N5400A EZJIT Plus Jitter Analysis software license (optional).

U7232A DisplayPort Compliance Testing Notes



In This Book

This manual describes the tests that are performed by the DisplayPort
Electrical Performance Compliance Test Application in more detail; it
contains information from (and refers to) the DisplayPort Specification
Version 1, and it describes how the tests are performed.

U7232A DisplayPort Compliance Testing Notes

Chapter 1, “Installing the DisplayPort Electrical Performance
Compliance Test Application shows how to install and license the
automated test application (if it was purchased separately).

Chapter 2, “Preparing to Take Measurements shows how to start the
DisplayPort Electrical Performance Compliance Test Application and
gives a brief overview of how it is used.

Chapter 3, “Source Eye Diagram Testing shows the probing and test
procedure of the data eye pattern tests.

Chapter 4, “Source Total Jitter Tests contains more information on the
source total jitter tests.

Chapter 5, “Source Non-ISI Jitter Tests contains more information on
the source non-isi jitter tests.

Chapter 6, “Source Transition Time Tests describes the rise time and
fall time tests.

Chapter 7, “Source No Pre-emphasis Level Verification Testing describes
the no pre-emphasis level verification tests.

Chapter 8, “Source Pre-emphasis Level Verification Testing describes the
pre-emphasis level verification tests.

Chapter 9, “Source Frequency Accuracy Tests describes the source
frequency accuracy tests.

Chapter 10, “Source Inter-Pair Skew Tests describes the source
inter- pair skew differential tests.

Chapter 11, “Source Rise And Fall Time Mismatch Tests describes
source intra-pair skew single-ended tests.

Chapter 12, “Source Intra-Pair Skew Tests describes source intra- pair
skew single-ended tests.

Chapter 13, “Source AC Common Mode Noise Tests describes source AC
common mode noise tests.

Chapter 14, “Calibrating the Infiniium Oscilloscope and Probe describes
how to calibrate the oscilloscope in preparation for running the
DisplayPort automated tests.

Chapter 15, “InfiniiMax Probing describes the 1168A/1169A probe
amplifier and probe head recommendations for DisplayPort testing.



See Also

e The DisplayPort Electrical Performance Compliance Test Application’s
online help, which describes:

Creating or opening a test project.

Setting up the DisplayPort test environment.
Selecting tests.

Configuring selected tests.

Connecting the oscilloscope to the DUT.
Running the tests.

Viewing the test results.

Viewing/printing the HTML test report.
Saving test projects.

Understanding the HTML report.
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® U7232A DisplayPort Electrical Performance Compliance Test Application
o Compliance Testing Notes

o0 @ Qo1
Installing the DisplayPort Electrical

o O
. : ®.  Performance Compliance Test
. Application

Installing the Software 12
Installing the License Key 13

If you purchased the U7232A DisplayPort Electrical Performance
Compliance Test Application separately, you need to install the software
and license key.

Agilent Technologies
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1 Installing the DisplayPort Electrical Performance Compliance Test Application

Installing the Software

1 Make sure you have version A.05.30 or higher of the Infiniium
oscilloscope software by choosing Help>About Infiniium... from the
main menu.

2 To obtain the DisplayPort Electrical Performance Compliance Test
Application, go to Agilent website:
http://www.agilent.com/fin - - SW.

~i.i~ Agilent Technologies % @;'
2 ca
[ Products & Services | Technical Support | Buy | Industries | About Agilent |

Search: |Driuers &Soﬂwarej | EI

Infiniium Analysis Options
Drivers & Software

Enter your product model number: [ Find |

Examples: 34401A, E4440A. Specify at least three characters for best resufts.,

Figure 1  Agilent website for software Downloads

3 Search the list on this web page for the link to the U7232A DisplayPort
Electrical Performance Compliance Test Application. Click on it and
follow the instructions to download and install the application.

12 U7232A DisplayPort Compliance Testing Notes
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Installing the DisplayPort Electrical Performance Compliance Test Application 1

Installing the License Key

1 Request a license code from Agilent by following the instructions on the
Entitlement Certificate.

You will need the oscilloscope’s “Option ID Number”, which you can
find in the Help>About Infiniium... dialog box.

2 After you receive your license code from Agilent, choose
Utilities>Install Option License....

3 In the Install Option License dialog, enter your license code and click
Install License.

4 C(Click OK in the dialog that tells you to restart the Infiniium
oscilloscope application software to complete the license installation.

5 Click Close to close the Install Option License dialog.
6 Choose File>Exit.

7 Restart the Infiniium oscilloscope application to complete the license
installation.

U7232A DisplayPort Compliance Testing Notes 13



1 Installing the DisplayPort Electrical Performance Compliance Test Application
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U7232A DisplayPort Electrical Performance Compliance Test Application
Compliance Testing Notes

2
Preparing to Take Measurements

W2641A Test Fixture 16
Calibrating the Oscilloscope 17

Starting the DisplayPort Electrical Performance Compliance Test
Application 18

Online Help Topics 20

Before running the DisplayPort automated tests, you need to acquire the
appropriate test fixtures, and you should calibrate the oscilloscope and
probe. After the oscilloscope and probe have been calibrated, you are
ready to start the DisplayPort Electrical Performance Compliance Test
Application and perform the measurements.

Agilent Technologies
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2  Preparing to Take Measurements

W2641A Test Fixture

The W2641A test fixture is the Agilent DisplayPort test fixture that is used
for all of the DisplayPort compliance tests.

Acquiring the Test Fixture

The W2641A DisplayPort test fixture can be acquired from Agilent
Technologies.

W2641A Test Fixture Description

Figure 2 shows the top view of the W2641A test fixture.
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Figure2 W2641A DisplayPort Test Fixture (Top View)
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Preparing to Take Measurements 2

Calibrating the Oscilloscope

If you haven't already calibrated the oscilloscope and probe, see
Chapter 14, “Calibrating the Infiniium Oscilloscope and Probe.

If the ambient temperature changes more than 5 degrees Celsius from the calibration
temperature, internal calibration should be performed again. The delta between the
calibration temperature and the present operating temperature is shown in the
Utilities>Calibration menu.

If you switch cables between channels or other oscilloscopes, it is necessary to perform
cable and probe calibration again. Agilent recommends that, once calibration is performed,
you label the cables with the channel on which they were calibrated.

U7232A DisplayPort Compliance Testing Notes 17



2

Preparing to Take Measurements

Starting the DisplayPort Electrical Performance Compliance Test

Application

18

1 From the Infiniium oscilloscope’s main menu, choose
Analyze>Automated Test Apps>DisplayPort Test.

Utilities Help

Math (FFT and more)...
Histogram...
Mask Test...

Vector Signal Analyzer...
M1 Oscilloscope Tools...

Jitter...
High Speed Serial Data...
Low Speed Serial Data...

Automated Test Apps » Display Port Test
»

FPGA Probe

DisplayPort -- DisplayPort 1
File View Help
O =

Task Flow [ ] Set Up lSeIect Tests | Configure | Connect | Run Tests | Results | Himl Repart |

DisplayPort Test Emaronment Setup

L
o
< b
B
=l

Seleck Tests

Welcome to DisplayPort Compliance Application.
This page will guide user to Define DisplayPort
DUT and Infiniium Cscilloscope Setting.

Setting Selection:
{* Wizard Mode Setting
" fhanual Mode Setting

Mext

118

I Hide Informative Test

0 Tests  Follow instructions to describe your kest environment Connection: UMKNOWH

Figure 3  The DisplayPort Electrical Performance Compliance Test Application
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Preparing to Take Measurements

If DisplayPort Test does not appear in the Automated Test Apps menu, the DisplayPort
Electrical Performance Compliance Test Application has not been installed (see Chapter 1,
“Installing the DisplayPort Electrical Performance Compliance Test Application).

2

Figure 3 shows the DisplayPort Electrical Performance Compliance Test
Application main window. The task flow pane, and the tabs in the main
pane, show the steps you take in running the automated tests:

Set Up

Select Tests

Configure

Connect

Run Tests

Results

HTML Report

Lets you select your setup options. Allows you to
setup by connection type, device identifier, jitter
separation measurements and test fixture type.

Lets you select the tests you want to run. The tests
are organized hierarchically, so you can select all
tests in a group. After tests are run, status indicators
show which tests have passed, failed, or not been
run, and there are indicators for the test groups.

Lets you enter information about the device being
tested and configure test parameters (like memory

depth). This information appears in the HTML report.

Shows you how to connect the oscilloscope to the
device under test for the tests to be run.

Starts the automated tests. If the connections to the
device under test need to be changed while multiple
tests are running, the tests pause, show you how to
change the connection, and wait for you to confirm
that the connections have been changed before
continuing.

Contains more detailed information about the tests
that have been run. You can change the thresholds at
which marginal or critical warnings appear.

Shows a compliance test report that can be printed.

When you close the DisplayPort application, each channel’s probe is configured as
single-ended or differential depending on the last DisplayPort test that was run.

U7232A DisplayPort Compliance Testing Notes
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2

Preparing to Take Measurements

Online Help Topics

20

For information on using the DisplayPort Electrical Performance
Compliance Test Application, see the online help (which you can access by
choosing Help>Contents... from the application’s main menu).

The DisplayPort Electrical Performance Compliance Test Application’s
online help describes:

Starting the DisplayPort Electrical Performance Compliance Test
Application.

To view or minimize the task flow pane.
To view or hide the toolbar.
Running the Compliance Test Application on a second monitor.
Creating or opening a test project.
Setting up DisplayPort test environment.
Selecting the tests.
Configuring selected tests.
Connecting the oscilloscope to the Device Under Test (DUT).
Running the tests.
Viewing test results.
To show reference images and flash mask hits.
To change margin thresholds.
To change report trial display.
Viewing or printing the HTML test report.
Saving the test projects.

Understanding the DisplayPort HTML report.

U7232A DisplayPort Compliance Testing Notes



U7232A DisplayPort Electrical Performance Compliance Test Application
o Compliance Testing Notes

ce0@® @03
‘0.. Source Eye Diagram Testing

[
° ® ©
° ® ‘ Probing for Differential Tests 22
° Source Eye Diagram Test 25

This section provides the guidelines for source data eye pattern differential
tests using an Agilent 8 GHz or greater Infiniium oscilloscope, 1168A or

1169A probes, and the DisplayPort Electrical Performance Compliance Test
Application.

Agilent Option 001 (1M/ch memory upgrade) is recommended; this will greatly reduce Data
Eye Pattern test time.

Agilent Technologies 21



3 Source Eye Diagram Testing

Probing for Differential Tests

When performing the data eye pattern test, the DisplayPort Electrical
Performance Compliance Test Application will prompt you to make the
proper connections. Your DisplayPort test environment setup on the Set
Up tab must match the physical connection. There are two modes that you
can use to configure the Set Up tab: Wizard Mode and Manual Mode. The
Wizard Mode leads you step by step through each of the different setup
choices with a description of what the choices do. The Manual Mode
allows you to choose only those set up choices that you want to make
without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 4 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the data eye test should be similar to Figure 5.

DisplayPort -- DisplayPort 1
File View Help
O @

Ln
o
o
E =
=]

Select Tests

118

Task Flow _| Setlp ]Select Tests ] Configure ] Connect ] Run Tests ] Results ] Hetril Report ]

0 Tests  Follow inskructions ko describe your test environment: Conneckion: MKMW

DisplayPort Test Emironment Setup

Device Type:

Fixture Type
jSource =] ||  DUTDefikion |
Test Type: Driven Seting

Agilent TPA |
!

Connection Type

|DiFFerenI:iaI Tesks -

Mo of Lanes

Lane-Ch y Connecton Model

Selection {* Differential Probe

2 Conneckions
j " Single-Ended (A-B)

<% Back to hain Page

[ Hide Informative Test

22

Figure 4  Setup for Data Eye Pattern Differential Tests (Two Connections with W2641A
DisplayPort Test Fixture)

Figure 6 shows a physical connection for making single-ended connections.
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Source Eye Diagram Testing 3

Infiniium Oscilloscope

N5380A SMA probe head.

Connect the plus side of the

probe to the plus side of the

SMA probe head and the

negative side of the probe to

the negative side of the SMA

probe head. DUT

SMA to SMP cables )
) 7\‘

el 8 000
Y gus

L © aep ® @@

0o .

N\ a2 ] = O oog
S =]
P ;000
1168A or 1169A <« OO0
Probe Amplifier a0
Lane on the W2641A test fixture e

Figure 5  Probing for Differential Tests - Data Eye Pattern Tests using the W2641A
DisplayPort Test Fixture)
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24

Source Eye Diagram Testing

Infiniium Oscilloscope

@

92 & Q{D

DUT

Data Channel I VE— G

Lane on the W2641A test fixture R a— R

Figure 6  Probing for Single-ended Tests - Data Eye Pattern Tests using the W2641A
DisplayPort Test Fixture

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.

For more information on the 1168A or 1169A probe amplifiers and
differential probe heads, see Chapter 15, “InfiniiMax Probing,” starting on
page 147.

U7232A DisplayPort Compliance Testing Notes



Source Eye Diagram Testing 3

Source Eye Diagram Test

The eye diagram test provides a visual evaluation of the amplitude and
timing variations of the waveform with the overall objective of obtaining a
specified Bit Error Rate in transmitted data. The test must use a PRBS7
test pattern at all voltage levels. The test should be performed without
pre- emphasis.

The source Eye Diagram performance provides the best visual assessment
of interoperability potential by showing amplitude and timing minimums
and maximum values.

Test Procedure

1

Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

Connect the W2641A test fixture to the device under test (DUT).

If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

In the DisplayPort Compliance Test Application, click the Set Up tab.

Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.

U7232A DisplayPort Compliance Testing Notes 25



3 Source Eye Diagram Testing

Navigate to the Eye Diagram - Lane # - Eye Diagram Test where # is the
lane number to be tested.

DisplayPort -- DisplayPort 1 * [;|[E|[X|
File View Help
0= & e Tl i |

Task Flaw J SetUp Select Tests lCDnFigure ] Connect ] Fun Tesks ] Results ] Htrl Report ]

el ---J© Display Port Tests
2 - Source Differential Tests

= ) Eye Diagram
) Lane O - Eye Diagram Test

+-[] 0 Total Jitker
et #-[J O Mor-IsI Mtter
+-J O Transition Time
v +--[J © Mon-PreEmphasis Level
+ D () Freguency Accuracy
Configure
Conneck
Test: (None Selected)
Description: (Select a Single Test)
Run Tesks
1 Testz  (Check the test(s) you would like bo run Conneckion: LIMERCWR

Figure 7  Selecting Data Eye Pattern Differential Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 1),
run the test and view the test results. Options may vary depending on
selected mode: Compliance Mode or Debug Mode.
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Table 1 Test Configuration Options

Source Eye Diagram Testing 3

Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:

®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length

Sets the memory depth used for FFT calculations.

U7232A DisplayPort Compliance Testing Notes
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3 Source Eye Diagram Testing

Table 1 Test Configuration Options
Configuration Option Description
FFT Acquisition Sets the number of acquisitions used for FFT calculations.
Source Differential Tests
Eye Diagram
Eye Diagram Edge Sets the number of edges measured for the eye test.
Mask Scaling Option Sets the type of scaling performed on the mask for the eye test.
Mask Type Selects the type of mask to use for the eye test.
Interpolation (Debug Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
only) Turning On interpolation may cause more peak-to-peak jitter.
Eye Diagram Mask This field contains 4 options. (1) Find Passing Mode will automatically
Movement (Debug only)  search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5U1 horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,
Jitter Separation Settings
Jitter Separation Edges Sets the number of edges measured for the jitter separation test.
Bit Error rate Sets the bit error rate for the RJ/DJ measurements.
Transition Time
Transition Edges Sets the number of edges measured for the transition tests.
Transition VH Pattern Sets the pattern that represents a high or one voltage when three or
(Debug only) more ones are transmitted in a row.
Transition VL Pattern Sets the pattern that represents a low or zero voltage when three or
(Debug only) more zeros are transmitted in a row.
Upper Threshold (Debug  Sets the upper threshold for the transition tests in percentage.
only)
Lower Threshold (Debug  Sets the lower threshold for the transition tests in percentage.
only)
Non-Pre-emphasis
Level Edges Sets the number of edges measured for the level test.
Pre-empabhsis Level
Pre-emphasis Edge Sets the number of edges measured for the level test.
Inter-pair Skew
Inter-pair Skew Edge Sets the number of edges measured for the inter-pair skew test.
Maximum Retries Sets the number of times that the application tries to measure the
inter-pair skew test before failing.
28 U7232A DisplayPort Compliance Testing Notes



Table 1 Test Configuration Options

Source Eye Diagram Testing

Configuration Option

Description

Spread Spectrum Clock (SSC)
SSC Acquisitions

Rise-Fall Mismatch
Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

The following table and figure define the mask for the eye measurements.
There can be no signal trajectories entering into the mask. Table 2 shows

the voltage and time coordinates for the mask used for the eye diagram.

U7232A DisplayPort Compliance Testing Notes
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3 Source Eye Diagram Testing

Table 2 Eye Diagram Mask Coordinates

Bit Rate
Mask Point Reduced (1.6 Gb/s) High (2.7 Gb/s)
1 0.102, 0.000 0.159, 0.000
2 0.277, 0.255 0.332,0.158
3 0.500, 0.318 0.500, 0.198
4 0.723,0.318 0.668, 0.198
5 0.899, 0.000 0.844,0.000
6 0.723,-0.318 0.665,-0.198
7 0.500,-0.318 0.500,-0.198
8 0.277,-0.255 0.332,-0.158

Figure 8 The Source Eye Pattern Mask

Mask Test: Zero mask failures.

Test References

See Test 3.1: Eye Diagram Testing, in the DisplayPort- Compliance Test
Specification Version 1.
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This section provides the guidelines for source total jitter tests using an
Agilent 8 GHz or greater Infiniium oscilloscope, InfiniiMax probes, and the
DisplayPort Electrical Performance Compliance Test Application.

Agilent Option 001 (1M/ch memory upgrade) is recommended; this will greatly reduce
Jitter test time.
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Source Total Jitter Tests

Probing for Total Jitter Test

When performing the total jitter test, the DisplayPort Electrical
Performance Compliance Test Application will prompt you to make the
proper connections. Your DisplayPort test environment setup on the Set
Up tab must match the physical connection. There are two modes that you
can use to configure the Set Up tab: Wizard Mode and Manual Mode. The
Wizard Mode leads you step by step through each of the different setup
choices with a description of what the choices do. The Manual Mode
allows you to choose only those set up choices that you want to make
without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 9 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the data eye test should be similar to Figure 10.

DisplayPort -- DisplayPort 1

File View Help
O =

i
@
e il
=
=

Select Tests

118

Task Flow _| SetUp lSeIect Tests ] Configure ] Conneck ] Run Tesks ] Results ] Htrnl Repart ]

0 Tests  Follow instructions to describe wour kest environment Conneckion: LRKMOYR

DisplayFort Test Emaronment Setup

Device Type:

|S|:n_|r|:e - DUT D i Fixture Type
1 Driven Setting d

Test Type: Agilent TPA v

|DiFFerentiaI Tesks -

l

Connection Type

No of Lanes
Lane-Ch y Connechon Model

Selection 1 9 @ Differential Probe
2 Conneckions -

" Single-Ended (4-E)

%% Back to Main Page

[ Hide Informative Test

32

Figure 9  Setup for Total Jitter Test (1 Connection with W2641A DisplayPort Parametric
Test Fixture)
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Source Total Jitter Tests

Figure 10 and Figure 11 below show the single-ended and differential
connections for the Total Jitter Tests.

Infiniium Oscilloscope

N5380A SMA probe head.

Connect the plus side of the

probe to the plus side of the

SMA probe head and the

negative side of the probe to

the negative side of the SMA

probe head. DUT

SMA to SMP cables
ﬁJ—wﬂ ; 7

anld g OO0
Qo . o UDD
= O aag

© 98P ® @(D

-

1168Aor1169A/

Probe Amplifier

Figure 10 Probing for Differential Tests - Total Jitter Tests (Two Connections with
W?2641A DisplayPort Test Fixture)

U7232A DisplayPort Compliance Testing Notes

Lane on the W2641A test fixture R a—
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Infiniium Oscilloscope

@ &b ® 98k

DUT

. N \\
SMA to SMP cablesL*‘S\/ Data Channel O —
- :

Lane on the W2641A test fixture R a—

Figure 11 Probing for Single-ended Tests - Total Jitter Tests using the W2641A
DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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Total Jitter Differential Test

To evaluate the total jitter accompanying the data transmission at either
an explicit bit error rate of 109 or through an approved estimation
technique. This measurement is a data time interval error (Data-TIE) jitter
measurement. (Reference: Table 3.13 VESA DisplayPort Standard)

The overall system jitter budget allocates different amounts of jitter which
each component of the system is allowed to contribute. To exceed any of
these limits is to violate the component level jitter budget. (Reference:
Jitter model in base DisplayPort Specification (Section 3.5.3.9: The Dual
Dirac Jitter Model)

The test must use a PRBS7 test pattern at all voltage levels. The test can
be performed with pre-emphasis for best performance results.

Test Procedure

1 Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

2 Connect the W2641A test fixture to the device under test (DUT).

3 If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

4 Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

b Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

6 In the DisplayPort Compliance Test Application, click the Set Up tab.

7 Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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Navigate to the Total Jitter - Lane # - where # is the lane number to be
tested.

DisplayPort -- DisplayPort 1 * DEX
File View Help
0= & "E pE o I | €Y

Task Flow _| sSetup 3Select Tests lCn:nnFigure ] Caonneck ] Run Tests ] Fesults ] Heml Repart ]

=il S8 Di=play Port Tesks
F -0 Source Differential Tests

+-[J ' Eye Diagram
 Total Jitter
) Lane O - Total Jitker Tesk
et fesis [1© mon-ISI Mtter
O < Transition Time
O & Mon-PreEmphasis Level

O & Frequency Accuracy
Configure

F-[H- - [F

Conneckt
Test: (None Selected)
Descripkion: (Select 3 Single Test)
Run Tesks
1 Tests  |Check the test(s) you would like ta run Canneckion: LNKNOWH

Figure 12 Selecting Total Jitter Differential Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 3),
run the test and view the test results. Options may vary depending on
selected mode: Compliance Mode or Debug Mode.
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Table 3 Test Configuration Options

Source Total Jitter Tests 4

Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length
FFT Acquisition

Eye Diagram
Eye Diagram Edge

Sets the memory depth used for FFT calculations.
Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.

U7232A DisplayPort Compliance Testing Notes
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Source Total Jitter Tests

Table 3 Test Configuration Options

38

Configuration Option

Description

Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask

Movement (Debug only)

Jitter Separation Settings

Jitter Separation Edges

Bit Error rate
Transition Time
Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug

only)

Lower Threshold (Debug

only)
Non-Pre-emphasis

Level Edges
Pre-empabhsis Level

Pre-emphasis Edge
Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Spread Spectrum Clock (SSC)

SSC Acquisitions

Rise-Fall Mismatch

Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.
Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests
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Source Total Jitter Tests

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

Table 4 Total Jitter at Internal and Compliance Points.

Transmitter package pin

Transmitter Connector (TP2)

High-bit Rate (2.7 Gh/s per lane)

App 0.260 UI 0.364 Ul
Reduced-bit Rate (1.62 Gb/s per lane)
App 0.160 UI 0.223 Ul

Ul is Unit Interval.

Test References

See Test 3.12: Total Jitter (TJ) Measurements in the
DisplayPort- Compliance Test Specification Version 1.
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This section provides the guidelines for source non-ISI jitter tests using an
Agilent 8 GHz or greater Infiniium oscilloscope, InfiniiMax probes, and the
DisplayPort Electrical Performance Compliance Test Application.

Agilent Option 001 (1M/ch memory upgrade) is recommended; this will greatly reduce
Jitter test time.
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Source Non-ISI Jitter Tests

Probing for Non-ISI Jitter Test

42

When performing the non-ISI jitter test, the DisplayPort Electrical
Performance Compliance Test Application will prompt you to make the
proper connections. Your DisplayPort test environment setup on the Set
Up tab must match the physical connection. There are two modes that you
can use to configure the Set Up tab: Wizard Mode and Manual Mode. The
Wizard Mode leads you step by step through each of the different setup
choices with a description of what the choices do. The Manual Mode
allows you to choose only those set up choices that you want to make
without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 13: one
Connection using the W2641A DisplayPort Parametric Test Fixture, 1168A
or 1169A differential probe with N5380A SMA probe head then your
physical connection for the jitter test should be similar to Figure 14.

DisplayPort -- DisplayPort 1
File View Help

=

O =

Task Flow :I Set Up ]Select Tests ] Configure ] Conneck ] Run Tests ] Reslts ] Hemnl Report ]

DisplayPort Test Emaronment Setup

T

\Welcorne to DisplayPort Compliance Application.
Selact Tests This page will guide user to Define DisplayPort
DUT and Infiniiurm Oscilloscope Setting.

Setting Selection:
{* \\izard Mode Setting
" Manual Mode Setting

et

8

[ Hide Informative Test

0Tests  Follow instructions bo describe vour best environment Connection: UMKNOWH

Figure 13 Setup for Non-ISI Jitter Test (1 Connection with W2641A DisplayPort
Parametric Test Fixture)

Figure 14 and Figure 15 below show the single-ended and differential
connections for Non-ISI Jitter Tests.
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Infiniium Oscilloscope

N5380A SMA probe head.

Connect the plus side of the

probe to the plus side of the

SMA probe head and the

negative side of the probe to

the negative side of the SMA

probe head. DUT

SMA to SMP cables . )
CI M S
o 0

© I9=Bb ® Q)@(Dl]

-

i

1168Aor1169A/

Probe Amplifier

Lane on the W2641A test fixture

Figure 14 Probing for Differential Tests - Non-ISI Jitter Tests (Two Connections with
W2641A DisplayPort Test Fixture)
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Infiniium Oscilloscope

@ &b ® 98k

DUT

. N \\
SMA to SMP cablesL*‘S\/ Data Channel O —
- :

Lane on the W2641A test fixture R a—

Figure 15 Probing for Single-ended Tests - Non-ISI Jitter Tests (Four Connections with
W2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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Non-ISI Jitter Test

To evaluate the Non-ISI jitter accompanying the data transmission at
either an explicit bit error rate of 102 or through an approved estimation
technique. (Reference: Table 3.13 VESA DisplayPort Standard)

The overall system jitter budget allocates different amounts of jitter which
each component of the system is allowed to contribute. To exceed any of
these limits is to violate the component level jitter budget. (Reference:
Jitter model in base DisplayPort Specification (Section 3.5.3.9: The Dual
Dirac Jitter Model)

The test must use a PRBS7 test pattern at all voltage levels. The test can
be performed with pre-emphasis for best performance results.

Test Procedure

1 Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

2 Connect the W2641A test fixture to the device under test (DUT).

3 If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

4 Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

b Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

6 In the DisplayPort Compliance Test Application, click the Set Up tab.

7 Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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Navigate to the Non-ISI Jitter - Lane # - Non-ISI Jitter Test where # is
the lane number to be tested.

DisplayPort -- DisplayPort 1 * |;||ﬁ|[g|
File View Help
e | 'yt T |6

Task Flow | serup Seleck Tests lCDnFigure ] Connect ] Run Tests ] Resulks ] Html Repart

et Up

- Source Differential Tests
+-[] ' Ewe Diagram
+--[J ' Total Jitker
= [#] O Mon-ISI Jtker

et et ©) Lane 0 - Mor-15T Jitker Test

+-[]© Transition Time
+--[] ' Mon-PreEmphasis Level
+-[] O Frequency Accuracy

Configure

Zonneck

T Test: {(Mone Selected)
Description: (Select a Single Tesk)
Run Tesks
1 Tests  (Check the testis) you would like to run Conneckion: LIMEMOYR

Figure 16 Selecting Data Eye Pattern Differential Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 5),
run the test and view the test results. Options may vary depending on
selected mode: Compliance Mode or Debug Mode.
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Table 5 Test Configuration Options

Source Non-ISl Jitter Tests B

Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length
FFT Acquisition

Eye Diagram
Eye Diagram Edge

Sets the memory depth used for FFT calculations.
Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.

U7232A DisplayPort Compliance Testing Notes
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Table 5 Test Configuration Options

48

Configuration Option

Description

Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask

Movement (Debug only)

Jitter Separation Settings

Jitter Separation Edges

Bit Error rate
Transition Time
Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug

only)

Lower Threshold (Debug

only)
Non-Pre-emphasis

Level Edges
Pre-empabhsis Level

Pre-emphasis Edge
Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Spread Spectrum Clock (SSC)

SSC Acquisitions

Rise-Fall Mismatch

Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.
Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests
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Source Non-ISI Jitter Tests

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

Table 6 Non-ISI Jitter at Internal and Compliance Points.

Transmitter package pin

Transmitter Connector (TP2)

High-bit Rate (2.7 Gh/s per lane)

Ao 0.260 U|

0.364 UI

Reduced-bit Rate (1.62 Gb/s per lane)

Aop 0.160 Ul

0.223 Ul

Ul is Unit Interval.

Test References

See Test 3.12: Non-ISI Jitter (TJ) Measurements in the
DisplayPort- Compliance Test Specification Version 1.
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This section provides the guidelines for source transition time tests using
an Agilent 8 GHz or greater Infiniium oscilloscope, 1168A or 1169A
probes, and the DisplayPort Electrical Performance Compliance Test
Application.
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6 Source Transition Time Tests

Probing for Transition Time Tests

When performing the transition time test, the DisplayPort Electrical
Performance Compliance Test Application will prompt you to make the
proper connections. Your DisplayPort test environment setup on the Set
Up tab must match the physical connection. There are two modes that you
can use to configure the Set Up tab: Wizard Mode and Manual Mode. The
Wizard Mode leads you step by step through each of the different setup
choices with a description of what the choices do. The Manual Mode
allows you to choose only those set up choices that you want to make
without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 17 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the transition time test should be similar to Figure 18.

DisplayPort -- DisplayPort 1

File \iew Help
O =

L
i
e @
=
=]

Select Tests

118

Task Flow :l Set Up lSeIect Tests ] Configure ] Conneck ] Run Tests ] Resulks ] Htrnl Report ]

0 Tests  Fallow instruckions to describe waour best enviranment Conneckion: LINKNOWRN

DisplayPort Test Emaronment Setup

Welcome to DisplayPort Compliance Application,
This page will guide user to Define DisplayPort
DUT and Infiniium Oscilloscope Setting.

Setting Selection:
+ Wizard Mode Setting
I Manual Mode Setting

Mexk

[ Hide Informative Test

52

Figure 17 Setup for Transition Time Differential Tests (Two Connections with W2641A
DisplayPort Test Fixture)
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Figure 18 and Figure 19 below show the single-ended and differential
connections for Transition Time Tests.

Infiniium Oscilloscope

N5380A SMA probe head.

Connect the plus side of the

probe to the plus side of the

SMA probe head and the

negative side of the probe to

the negative side of the SMA

probe head. DUT

SMA to SMP cables
ﬁJ—wﬂ ; 7

anld g OO0
Qo . o UDD
= O aag

© 98P ® @(D

-

1168Aor1169A/

Probe Amplifier
Lane on the W2641A test fixture N s—

Figure 18 Probing for Differential Tests - Transition Time Tests (Two Connections with
W2641A DisplayPort Test Fixture)
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Infiniium Oscilloscope

@ &b ® 98k

DUT

. N \\
SMA to SMP cablesL*‘S\/ Data Channel O —
- :

Lane on the W2641A test fixture R a—

Figure 19 Probing for Single-ended Tests - Transition Time Tests (Four Connections with
W?2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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Source Transition Time Differential Tests

Transition time testing measures the rise time and fall time across the
outputs of a differential data lane. The transition is defined as the time
interval between the normalized 20% and 80% amplitude levels.

The transition time test should be performed at all bit rates supported
without pre-emphasis for 400 mV differential voltage swing. The source
pattern should be a PRBS7 waveform. This applies to one, two, and four
lane operation with all functional lanes being tested. (Reference: Table 3.10
VESA DisplayPort Standard)

Test Procedure

1

Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

Connect the W2641A test fixture to the device under test (DUT).

If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

In the DisplayPort Compliance Test Application, click the Set Up tab.

Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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Navigate to the Transition Time group, and check the rise time and fall
time tests that you want to perform.

DisplayPort -- DisplayPort 1 * |Z||E|[g|
File \iew Help
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Figure 20 Selecting Transition Time Differential Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 7),
make oscilloscope connections, run the tests, and view the tests results.
Options may vary depending on the selected mode: Compliance Mode or
Debug Mode.
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Table 7 Test Configuration Options

Source Transition Time Tests 6

Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length
FFT Acquisition

Eye Diagram
Eye Diagram Edge

Sets the memory depth used for FFT calculations.
Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.

U7232A DisplayPort Compliance Testing Notes
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Source Transition Time Tests

Table 7 Test Configuration Options
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Configuration Option

Description

Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask

Movement (Debug only)

Jitter Separation Settings

Jitter Separation Edges

Bit Error rate
Transition Time
Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug

only)

Lower Threshold (Debug

only)
Non-Pre-emphasis

Level Edges
Pre-empabhsis Level

Pre-emphasis Edge
Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Spread Spectrum Clock (SSC)

SSC Acquisitions

Rise-Fall Mismatch

Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.
Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests
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Table 7 Test Configuration Options

Source Transition Time Tests

6

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

50 ps < Transition Time < 160 ps

Test References

See section 3.6, in the DisplayPort- Compliance Test Specification Version

1.
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® U7232A DisplayPort Electrical Performance Compliance Test Application
o Compliance Testing Notes

o0 @ @0 ]
.Q.. Source No Pre-emphasis Level
> & *_  \Verification Testing

Probing for No Pre-emphasis Level Verification Testing 62
No Pre-emphasis Level Verification Test 65

This section provides the guidelines for source no pre-emphasis level
verification testing using an Agilent 8 GHz or greater Infiniium
oscilloscope, 1168A or 1169A probes, and the DisplayPort Electrical
Performance Compliance Test Application.

Agilent Technologies
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7  Source No Pre-emphasis Level Verification Testing

Probing for No Pre-emphasis Level Verification Testing

When performing the no pre-emphasis level verification test, the
DisplayPort Electrical Performance Compliance Test Application will
prompt you to make the proper connections. Your DisplayPort test
environment setup on the Set Up tab must match the physical connection.
There are two modes that you can use to configure the Set Up tab: Wizard
Mode and Manual Mode. The Wizard Mode leads you step by step through
each of the different setup choices with a description of what the choices
do. The Manual Mode allows you to choose only those set up choices that
you want to make without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 21 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the no pre-emphasis level verification test should be similar
to Figure 22.
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Task Flow :l Set Up lSeIect Tests ] Configure ] Conneck ] Run Tests ] Results ] Htrnl Repart ]

0 Tests  Follow instructions o describe your best environment Conneckion: LIMKNOWRN

DisplayFort Test Emiaronment Setup

Welcome to DisplayPort Compliance Application,
This page will guide user ta Define DisplayPort
DUT and Infiniium Oscilloscope Setting.

Setting Selection:
* Wizard Mode Setting
" Manual Mode Setting

Mexk

[ Hide Informmative Test
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Figure 21 Setup for no pre-emphasis level verification Differential Tests (Two
Connections with W2641A DisplayPort Test Fixture)
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Infiniium Oscilloscope

N5380A SMA probe head.

Connect the plus side of the

probe to the plus side of the

SMA probe head and the

negative side of the probe to

the negative side of the SMA

probe head. DUT

SMA to SMP cables . i
CI M S
o 0

© I9=Bb ® Q)@(Dl]

-

e —

1168Aor1169A/

Probe Amplifier

Lane on the W2641A test fixture

Figure 22 Probing for Differential Tests - No Pre-emphasis Level Verification Tests (Two
Connections with W2641A DisplayPort Test Fixture)
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Infiniium Oscilloscope

@ &b ® 98k

DUT

. N \\
SMA to SMP cablesL*‘S\/ Data Channel O —
- :

Lane on the W2641A test fixture R a—

Figure 23 Probing for Single-ended Tests - No Pre-emphasis Level Verification Tests (Two
Connections with W2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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No Pre-emphasis Level Verification Test

To evaluate the waveform peak differential amplitude to ensure signal is
neither over, nor under driven. (Reference: Table 3.10 VESA DisplayPort
Standard)

The source is given a range of expected output for each level setting that
correlates with the system budget elements such as cable loss and receiver
eye minimum and max values. This test ensures that the system budget
is obeyed.

The amplitude measurement is performed using the following equation at
all bit rates without pre-emphasis and a PRBS 7 waveform:

Peak- to- peak Voltage = Vg - V|,
where:

Vg is the high voltage level
V1, is the low voltage level

Test Procedure

1 Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

2 Connect the W2641A test fixture to the device under test (DUT).

3 If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

4 Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

5 Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

6 In the DisplayPort Compliance Test Application, click the Set Up tab.

7 Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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Figure 24 Selecting No Pre-emphasis Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 8),
make oscilloscope connections, run the tests, and view the test results.
Options may vary depending on the selected mode: Compliance Mode or
Debug Mode.
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Table 8 Test Configuration Options

Source No Pre-emphasis Level Verification Testing 7

Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length
FFT Acquisition

Eye Diagram
Eye Diagram Edge

Sets the memory depth used for FFT calculations.
Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.
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Source No Pre-emphasis Level Verification Testing

Table 8 Test Configuration Options

68

Configuration Option

Description

Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask
Movement (Debug only)

Jitter Separation Settings
Jitter Separation Edges
Bit Error rate

Transition Time
Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Non-Pre-emphasis

Level Edges
Pre-empabhsis Level

Pre-emphasis Edge
Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Spread Spectrum Clock (SSC)
SSC Acquisitions

Rise-Fall Mismatch

Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.
Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests
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Table 8 Test Configuration Options

Source No Pre-emphasis Level Verification Testing

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

The peak-to-peak voltage must fall within the following ranges for each

output level:

Output level 1 (0.4 V): 0.34 V < Result <0.46 V

Output level 2 (0.6 V): 0.51 V < Result £0.68 V

Output level 3 (0.8 V): 0.69 V < Result <0.92 V

Output level 4 (1.2 V): 1.02 V < Result £1.38 V

Test References

See Test 3-2: No Pre-emphasis Level Verification Testing, in the
DisplayPort- Compliance Test Specification Version 1.
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® U7232A DisplayPort Electrical Performance Compliance Test Application
o Compliance Testing Notes
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Source Pre-emphasis Level Verification
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Probing for Pre-emphasis Level Verification Testing 72
Pre-emphasis Level Verification Test 75

This section provides the guidelines for source pre-emphasis level
verification testing using an Agilent 8 GHz or greater Infiniium
oscilloscope, 1168A or 1169A probes, and the DisplayPort Electrical
Performance Compliance Test Application.
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8  Source Pre-emphasis Level Verification Testing

Probing for Pre-emphasis Level Verification Testing

When performing the pre-emphasis level verification test, the DisplayPort
Electrical Performance Compliance Test Application will prompt you to
make the proper connections. Your DisplayPort test environment setup on
the Set Up tab must match the physical connection. There are two modes
that you can use to configure the Set Up tab: Wizard Mode and Manual
Mode. The Wizard Mode leads you step by step through each of the
different setup choices with a description of what the choices do. The
Manual Mode allows you to choose only those set up choices that you
want to make without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 25 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the pre-emphasis level verification test should be similar to
Figure 26.
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This page will guide user to Define DisplayPort
DUT and Infinfium Cscilloscope Setting,

Setting Selection:
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£ manual ode Setting

Mexk
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Figure 25 Setup for pre-emphasis level verification Differential Tests (Two Connections
with W2641A DisplayPort Test Fixture)
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Source Pre-emphasis Level Verification Testing
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Figure 26 Probing for Differential Tests - Pre-emphasis Level Verification Tests (Two
Connections with W2641A DisplayPort Test Fixture)
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Source Pre-emphasis Level Verification Testing

Infiniium Oscilloscope

@
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DUT
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Lane on the W2641A test fixture R a—

Figure 27 Probing for Single-ended Tests - Pre-emphasis Level Verification Tests (Two
Connections with W2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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Source Pre-emphasis Level Verification Testing 8

Pre-emphasis Level Verification Test

This test evaluates the effect of pre-emphasis on the source waveform by
measuring the peak differential amplitude and assuring the accuracy of the
pre-emphasis setting. (Reference: Table 3.10 VESA DisplayPort Standard)

The source can apply pre-emphasize to the waveform in order to
overcome the harmful effects caused by such things as system losses
through pc boards, connectors, and cables. The standard stipulates the
relative magnitude to overcome specific losses. Because pre-emphasis is
negotiated, two units with substantially different degrees of pre-emphasis
may be seen as non-interoperable under certain conditions. This test
ensures that the system loss or pre-emphasis budget is obeyed.

Tests must be made on all bit rates supported with pre-emphasis for all
differential voltage swings supported using a test pattern of PRMS 7. The
following equation is used to calculate the pre-emphasis result:

Vo .
Pre-emphasis Result = ZOlog{Mj

Swingnope
VSwingpe = (VHpe_ VLpe)
VSwingnope = (VHnope_ VLnope)

where:

Vhpe = the high voltage value is measured using the histogram modes
at the top for transition eyes.

Vipe = the low voltage value is measured using the histogram modes
at the top for transition eyes.

VHnope = the high voltage value is measured using the histogram modes
at the top for non-transition eyes.

VLnope = the high voltage value is measured using the histogram modes
at the top for non-transition eyes.

Test Procedure

1 Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

2 Connect the W2641A test fixture to the device under test (DUT).

3 If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
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channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

4 Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

b Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

6 In the DisplayPort Compliance Test Application, click the Set Up tab.

7 Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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Figure 28 Selecting Pre-emphasis Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 9),
make oscilloscope connections, run the tests, and view the test results.
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Options may vary depending on the selected mode: Compliance Mode or
Debug Mode.
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Table 9 Test Configuration Options

Configuration Option Description

Clock Recovery

Clock Recovery Order Set either a second order PLL or a first order PLL method is used to
recover the clock.

Clock Recovery Loop Sets the 3 dB bandwidth of the loop filter used by the PLL.
Bandwidth

Clock Recovery Damping  Sets the damping factor which is the value that is used in designing

Factor the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Prerequisite Settings

Bandwidth Reduction Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Vswing Edge Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

VTop & VBase Edge Sets the number of edges required when making the VTop and VBase
measurements.

VH Pattern (Debug only)  Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

VL Pattern (Debug only)  Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings
FFT Memory Length Sets the memory depth used for FFT calculations.
FFT Acquisition Sets the number of acquisitions used for FFT calculations.
Source Differential Tests
Eye Diagram

Eye Diagram Edge Sets the number of edges measured for the eye test.
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Source Pre-emphasis Level Verification Testing

Configuration Option

Description

Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask
Movement (Debug only)

Jitter Separation Settings
Jitter Separation Edges
Bit Error rate

Transition Time
Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Non-Pre-emphasis

Level Edges
Pre-empabhsis Level

Pre-emphasis Edge
Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Spread Spectrum Clock (SSC)
SSC Acquisitions

Rise-Fall Mismatch

Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.
Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests
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Table 9 Test Configuration Options

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

The pre-emphasis calculation must fall within the following ranges for
each pre-emphasis level:

3.5 dB setting: 2.8 dB < Result <4.2 dB

6.0 dB setting: 4.8 dB < Result <7.2 dB

9.5 dB setting: 7.6 dB < Result <11.4 dB

Test References

See Test 3-3: Pre-emphasis Level Verification Testing, in the
DisplayPort- Compliance Test Specification Version 1.
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This section provides the guidelines for source frequency accuracy
differential tests using an Agilent 8 GHz or greater Infiniium oscilloscope,
InfiniiMax probes, and the DisplayPort Electrical Performance Compliance
Test Application.

Agilent Option 001 (1M/ch memory upgrade) is recommended; this will greatly reduce
frequency accuracy test time.
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9  Source Frequency Accuracy Tests

Probing for Frequency Accuracy Tests

When performing the frequency accuracy test, the DisplayPort Electrical
Performance Compliance Test Application will prompt you to make the
proper connections. Your DisplayPort test environment setup on the Set
Up tab must match the physical connection. There are two modes that you
can use to configure the Set Up tab: Wizard Mode and Manual Mode. The
Wizard Mode leads you step by step through each of the different setup
choices with a description of what the choices do. The Manual Mode
allows you to choose only those set up choices that you want to make
without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 29 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the frequency accuracy test should be similar to Figure 30.
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Task Flow :l Set Up lSeIect Tesks ] Configure ] Conneck ] Run Tests ] Resulks ] Htrnl Feport ]

0 Tests  Follow instructions to describe wour test environment Conneckion: LINKNOWR

DisplayPort Test Emaronment Setup

Welcame to DisplayPort Compliance Application.
This page will guide user to Define DisplayPart
DUT and Infiniium Dscilloscope Setting,

Setting Selection:
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Figure 29 Setup for Frequency Accuracy Differential Tests (Two Connections with
W2641A DisplayPort Test Fixture)
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Infiniium Oscilloscope
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Figure 30 Probing for Single-ended Tests - Frequency Accuracy Tests (Two Connections
with W2641A DisplayPort Test Fixture)
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Infiniium Oscilloscope

@ &b ® 98k

DUT

. N \\
SMA to SMP cablesL*‘S\/ Data Channel O —
- :

Lane on the W2641A test fixture R a—

Figure 31 Probing for Differential Tests - Frequency Accuracy Tests (Two Connections
with W2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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Frequency Accuracy Test

The frequency accuracy measurement of the distributed clock network
verifies that the nominal operating clock frequency is within the
acceptable tolerance range. In order for sink devices to properly recover
the data, the source clock must operate within the acceptable tolerance
range.

The test must be made at all bit rates supported by the device under test
without pre-emphasis and a voltage swing of 1.2 volts. A test pattern of
D10.2 should be used.

Test Procedure

1

Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

Connect the W2641A test fixture to the device under test (DUT).

If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

In the DisplayPort Compliance Test Application, click the Set Up tab.

Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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Navigate to the Frequency Accuracy group, and check the lanes that you
want to perform.

DisplayPort -- DisplayPort 1 * |Z||E|[X|
File \iew Help
I = N @ T

TaskFlow _| sSetUp Select Tests lCnnFigure ] Conneck ] Fun Tests ] Resulks ] Htril Repart ]
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<

Conneck
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Description: {Select a Single Tesk)
Run Tests

1 Tests  |(Check the kest(s) vou would like to run Connection: LIMKMOWR

<

Figure 32 Selecting Transition Time Differential Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 10),
make oscilloscope connections, run the tests, and view the tests results.
Options may vary depending on the selected mode: Compliance Mode or
Debug Mode.
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Table 10 Test Configuration Options

Source Frequency Accuracy Tests 9

Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length
FFT Acquisition

Eye Diagram
Eye Diagram Edge

Sets the memory depth used for FFT calculations.
Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.

U7232A DisplayPort Compliance Testing Notes
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Table 10 Test Configuration Options

88

Configuration Option

Description

Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask

Movement (Debug only)

Jitter Separation Settings

Jitter Separation Edges

Bit Error rate
Transition Time
Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug

only)

Lower Threshold (Debug

only)
Non-Pre-emphasis

Level Edges
Pre-empabhsis Level

Pre-emphasis Edge
Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Spread Spectrum Clock (SSC)

SSC Acquisitions

Rise-Fall Mismatch

Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.
Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests
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Source Frequency Accuracy Tests

9

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.
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9  Source Frequency Accuracy Tests

PASS Condition

Frequency Accuracy = Nominal Frequency *300 ppm.

Test References

See Test 3.9: Frequency Accuracy, in the DisplayPort- Compliance Test
Specification Version 1.
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This section provides the guidelines for source inter-pair skew
single-ended tests using an Agilent 8 GHz or greater Infiniium oscilloscope,
InfiniiMax probes, and the DisplayPort Electrical Performance Compliance
Test Application.

Agilent Technologies 9



10 Source Inter-Pair Skew Tests

Probing for Inter-Pair Skew Single-ended Tests

When performing the inter-pair skew test, the DisplayPort Electrical
Performance Compliance Test Application will prompt you to make the
proper connections. Your DisplayPort test environment setup on the Set
Up tab must match the physical connection. There are two modes that you
can use to configure the Set Up tab: Wizard Mode and Manual Mode. The
Wizard Mode leads you step by step through each of the different setup
choices with a description of what the choices do. The Manual Mode
allows you to choose only those set up choices that you want to make
without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 33 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the inter-pair skew test should be similar to Figure 34
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Figure 33 Setup for Inter-Pair Skew Differential Tests (Two Connections with W2641A
DisplayPort Test Fixture)
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Figure 34 Probing for Differential Tests - Inter-Pair Skew Tests (Two Connections with
W2641A DisplayPort Test Fixture)
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9
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Figure 35 Probing for Single-ended Tests - Inter-Pair Skew Tests (Two Connections with
W2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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Inter-Pair Skew Test

The inter-pair skew test evaluates the skew, or time delay, between
respective differential data lanes in the DisplayPort interface. (Reference
Table 3.10 VESA DisplayPort Standard)

The DisplayPort interface has the ability to skew, or deskew lanes by

20 UI (Unit Intervals) which is as much as 12ns (1.62Gb/s) and is
intended to eliminate simultaneous degradation of concurrent bytes of
transmitted data. The specification at 150 ps at the package pins(TP1),
likely to be degraded another 50 ps through the connector, is less than 0.5
Ul at the highest bit rate. Therefore, it is unlikely to be a significant
reason for non-interoperability.

Channel-to- channel de-skew must be performed on the two oscilloscope
channels used for this measurement (see “Differential Probe Head Skew
Calibration" on page 139 and “SMA Probe Head Skew Calibration" on
page 145).

Test Procedure

1 Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

2 Connect the W2641A test fixture to the device under test (DUT).

3 If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

4 Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

5 Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

6 In the DisplayPort Compliance Test Application, click the Set Up tab.

7 Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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10 Source Inter-Pair Skew Tests

Navigate to the Inter-pair Skew Test group, and check the rise time and
fall time tests that you want to perform.

DisplayPort -- DisplayPort 1 * [Z|[E|[X|
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0= H Ly e I | €Y

Task Flow _ : .
ERUH Selected Brarch DHW!: ] Run Tests ] Results ] Htrl Report ]
—|--J > Display Port Tests
SEtM --- © Source Differential Tests

+-[J O Eve Diagram
+-[J © Total Jitter
+-[0 O Mon-ISI Mtker
et +-[J © Transition Time
+-[J © Mon-PreEmphasis Level
v - O Inter Pair Skew
O Lane Of Lane 2- Inker Pair Skew Test
Configure +-[] O Frequency Accuracy
v
Conneck

Test: {(Mone Selected)

A\ 4

Description: {Select a Single Tesk)
Run Tests

1 Tests  |(Check the kest(s) vou would like to run Connection: LIMKMOWR

Figure 36 Selecting Transition Time Differential Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 11),
make oscilloscope connections, run the tests, and view the tests results.
Options may vary depending on the selected mode: Compliance Mode or
Debug Mode.
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Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length
FFT Acquisition

Eye Diagram
Eye Diagram Edge

Sets the memory depth used for FFT calculations.
Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.
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Configuration Option

Description

Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask

Movement (Debug only)

Jitter Separation Settings

Jitter Separation Edges

Bit Error rate
Transition Time
Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug

only)

Lower Threshold (Debug

only)
Non-Pre-emphasis

Level Edges
Pre-empabhsis Level

Pre-emphasis Edge
Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Spread Spectrum Clock (SSC)

SSC Acquisitions

Rise-Fall Mismatch

Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.
Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests
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10

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

Inter- Pair Skew < 2 Ul

Test References

See Test 3.4: Inter-Pair Skew Measurement, in the
DisplayPort- Compliance Test Specification Version 1.
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Source Rise And Fall Time Mismatch Tests 105

This section provides the guidelines for source transition time tests using
an Agilent 8 GHz or greater Infiniium oscilloscope, 1168A or 1169A
probes, and the DisplayPort Electrical Performance Compliance Test
Application.
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11 Source Rise And Fall Time Mismatch Tests

Probing for Single-ended Tests

When performing the transition time test, the DisplayPort Electrical
Performance Compliance Test Application will prompt you to make the
proper connections. Your DisplayPort test environment setup on the Set
Up tab must match the physical connection. There are two modes that you
can use to configure the Set Up tab: Wizard Mode and Manual Mode. The
Wizard Mode leads you step by step through each of the different setup
choices with a description of what the choices do. The Manual Mode
allows you to choose only those set up choices that you want to make
without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 37 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the transition time test should be similar to Figure 38.
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Figure 37 Setup for Rise And Fall Time Mismatch Tests (Two Connections with W2641A
DisplayPort Test Fixture)
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Figure 38 and Figure 39 below show the single-ended and differential
connections for Transition Time Tests.
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SMA probe head and the

negative side of the probe to

the negative side of the SMA

probe head. DUT

SMA to SMP cables
ﬁJ—wﬂ ; 7

anld g OO0
Qo . o UDD
= O aag

© 98P ® @(D

-

1168Aor1169A/

Probe Amplifier
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Figure 38 Probing for Differential Tests - Transition Time Tests (Two Connections with
W2641A DisplayPort Test Fixture)
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Figure 39 Probing for Single-ended Tests - Rise and Fall Time Mismatch Tests (Four
Connections with W2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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Source Rise And Fall Time Mismatch Tests

The rise and fall time mismatch tests evaluate the difference in rise and
fall times of the two single-ended waveform in a given differential data
lane of a DisplayPort interface. (Reference Table 3.10 VESA DisplayPort
Standard specification.)

The mismatch in time of the rising and falling time of the single-ended
signals composing a differential lane will create common mode noise and
will radiate.

The rise and fall times are measured between the 80% and 20% levels of
the waveform.

Test Procedure

1

Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

Connect the W2641A test fixture to the device under test (DUT).

If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

In the DisplayPort Compliance Test Application, click the Set Up tab.

Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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Navigate to the Rise-Fall Mismatch group, and check the Rising Mismatch
and Falling Mismatch tests that you want to perform.
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Figure 40 Selecting Rise And Fall Time Mismatch Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 12),
make oscilloscope connections, run the tests, and view the tests results.
Options may vary depending on the selected mode: Compliance Mode or

Debug Mode.
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Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length
FFT Acquisition

Eye Diagram
Eye Diagram Edge

Sets the memory depth used for FFT calculations.
Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.
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Table 12 Test Configuration Options

Configuration Option Description
Mask Scaling Option Sets the type of scaling performed on the mask for the eye test.
Mask Type Selects the type of mask to use for the eye test.
Interpolation (Debug Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
only) Turning On interpolation may cause more peak-to-peak jitter.
Eye Diagram Mask This field contains 4 options. (1) Find Passing Mode will automatically

Movement (Debug only)  search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Jitter Separation Settings
Jitter Separation Edges  Sets the number of edges measured for the jitter separation test.
Bit Error rate Sets the bit error rate for the RJ/DJ measurements.

Transition Time

Transition Edges Sets the number of edges measured for the transition tests.
Transition VH Pattern Sets the pattern that represents a high or one voltage when three or
(Debug only) more ones are transmitted in a row.

Transition VL Pattern Sets the pattern that represents a low or zero voltage when three or
(Debug only) more zeros are transmitted in a row.

Upper Threshold (Debug  Sets the upper threshold for the transition tests in percentage.
only)

Lower Threshold (Debug  Sets the lower threshold for the transition tests in percentage.
only)

Non-Pre-emphasis

Level Edges Sets the number of edges measured for the level test.
Pre-empabhsis Level

Pre-emphasis Edge Sets the number of edges measured for the level test.
Inter-pair Skew

Inter-pair Skew Edge Sets the number of edges measured for the inter-pair skew test.

Maximum Retries Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Spread Spectrum Clock (SSC)
SSC Acquisitions Sets the number of acquisitions taken to verify the SSC.
Single-ended Tests

Rise-Fall Mismatch
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Table 12 Test Configuration Options

Source Rise And Fall Time Mismatch Tests

1

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

Falling Mismatch <
>

Rising Mismatch

Test References

15% of the single-ended rise time
15% of the single-ended fall time

See section 3.7, in the DisplayPort- Compliance Test Specification Version

1.
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o Compliance Testing Notes
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° Intra-Pair Skew Test 115

This section provides the guidelines for source intra-pair skew tests using
an Agilent 8 GHz or greater Infiniium oscilloscope, InfiniiMax probes, and
the DisplayPort Electrical Performance Compliance Test Application.

Agilent Technologies 11



12 Source Intra-Pair Skew Tests

Probing for Single-Ended Tests

When performing the intra-pair skew test, the DisplayPort Electrical
Performance Compliance Test Application will prompt you to make the
proper connections. Your DisplayPort test environment setup on the Set
Up tab must match the physical connection. There are two modes that you
can use to configure the Set Up tab: Wizard Mode and Manual Mode. The
Wizard Mode leads you step by step through each of the different setup
choices with a description of what the choices do. The Manual Mode
allows you to choose only those set up choices that you want to make
without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 41 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the data eye test should be similar to Figure 42.

DisplayPort -- DisplayPort 1
File View Help
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Seleck Tests
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Task Flow _| SetUp ]Select Tests ] Configure ] Conneck ] Fun Tests ] Fesulks ] Htrl Report ]

0 Tests  Fallow instructions to describe waour kest environment Conneckion: UMENCWRN

DisplayFPort Test Emaronment Setup

Device Type: -
|S|:|L|r|:e j DUTD i Fixture Type
d Drniven Settng >
Test Type: Agilent TRA ]
|DiFFerentiaI Tests j
]
Mo of Lanes 2
Connection Model Connection T ype
Lane - Channel — "
Selection * Differential Probe
2 Conneckions j
" Single-Ended (A-B)

<< Back to Main Page

[ Hide Informative Test

112

Figure 41 Setup for Intra-pair Skew Differential Tests (Two Connections with W2641A
DisplayPort Test Fixture)
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Infiniium Oscilloscope

N5380A SMA probe head.

Connect the plus side of the

probe to the plus side of the

SMA probe head and the

negative side of the probe to

the negative side of the SMA

probe head. DUT

SMA to SMP cables . i
CI M S
o 0

© I9=Bb ® Q)@(Dl]

-

e —

1168Aor1169A/

Probe Amplifier

Lane on the W2641A test fixture

Figure 42 Probing for Differential - Intra-pair Skew Tests (Two Connections with W2641A
DisplayPort Test Fixture)
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114

Infiniium Oscilloscope

@

92 & QD

DUT

. N \\
SMA to SMP cablesL*‘S\/ Data Channel O —
- :

Lane on the W2641A test fixture R a—

Figure 43 Probing for Single-ended Tests - Inter-Pair Skew Tests (Two Connections with
W2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test
Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you
want.
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Source Intra-Pair Skew Tests 12

Intra-Pair Skew Test

The intra-pair skew test evaluates the skew, or time delay, between
respective sides of a differential data lane in a DisplayPort interface.
(Reference Table 3.10 VESA DisplayPort Standard)

Intra- pair skew has deleterious effects on signal rise time and manner of
crossing through the transition point. The DisplayPort specification at
package pins (TP1) is 20 ps. It can clearly double or triple to and through
the connector. These are secondary contributors to source jitter
performance.

Test Procedure

1

Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

Connect the W2641A test fixture to the device under test (DUT).

If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

In the DisplayPort Compliance Test Application, click the Set Up tab.

Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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12 Source Intra-Pair Skew Tests

Navigate to the Intra-Pair Skew group, and check the lane you want to
test.

DisplayPort -- DisplayPort 1 * |Z”E”Z|
File View Help
[ = H Y o I 4]

TaskFlow _| sSetUp Select Tests lCnnFigure ] Conneck ] Fun Tests ] Resulks ] Htril Repart ]

cot U OB [izplay Pork Tesks
: -0 © Source Single-Ended Tests

+-[J O Rise-Fall MisMatch
- O Intra Pair Skew

) Lane 0- Intra Pair Skew Test
et +-[J O AC Common Made

<

Configure

<

Conneck

Test: {(Mone Selected)

Description: {Select a Single Tesk)
Run Tests

1 Tests  |(Check the kest(s) vou would like to run Connection: LIMKMOWR

<

Figure 44 Selecting Intra-pair Skew Differential Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 13),
make oscilloscope connections, run the tests, and view the tests results.
Options may vary depending on the selected mode: Compliance Mode or

Debug Mode.
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Table 13 Test Configuration Options

Source Intra-Pair Skew Tests 12

Configuration Option

Description

Clock Recovery

Clock Recovery Order
Clock Recovery Loop

Bandwidth

Clock Recovery Damping
Factor

Prerequisite Settings

Bandwidth Reduction

Vswing Edge

VTop & VBase Edge

VH Pattern (Debug only)

VL Pattern (Debug only)

Set either a second order PLL or a first order PLL method is used to
recover the clock.

Sets the 3 dB bandwidth of the loop filter used by the PLL.

Sets the damping factor which is the value that is used in designing
the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:
®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

Sets the number of edges required when making the VTop and VBase
measurements.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length
FFT Acquisition

Eye Diagram
Eye Diagram Edge

Sets the memory depth used for FFT calculations.
Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.
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Table 13 Test Configuration Options

118

Configuration Option

Description

Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask

Movement (Debug only)

Jitter Separation Settings

Jitter Separation Edges

Bit Error rate
Transition Time
Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug

only)

Lower Threshold (Debug

only)
Non-Pre-emphasis

Level Edges
Pre-empabhsis Level

Pre-emphasis Edge
Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Spread Spectrum Clock (SSC)

SSC Acquisitions

Rise-Fall Mismatch

Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5Ul horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.
Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests
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Table 13 Test Configuration Options

Source Intra-Pair Skew Tests

12

Configuration Option

Description

Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

Intra-pair Skew < 30 ps

Test References

See Test 3.5: in the DisplayPort- Compliance Test Specification Version 1.
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This section provides the guidelines for source AC common mode noise
differential tests using an Agilent 8 GHz or greater Infiniium oscilloscope,
InfiniiMax probes, and the DisplayPort Electrical Performance Compliance
Test Application.

Agilent Option 001 (1M/ch memory upgrade) is recommended; this will greatly reduce AC
common mode noise test time.
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13 Source AC Common Mode Noise Tests

Probing for AC Common Mode Noise Tests

When performing the AC common mode noise test, the DisplayPort
Electrical Performance Compliance Test Application will prompt you to
make the proper connections. Your DisplayPort test environment setup on
the Set Up tab must match the physical connection. There are two modes
that you can use to configure the Set Up tab: Wizard Mode and Manual
Mode. The Wizard Mode leads you step by step through each of the
different setup choices with a description of what the choices do. The
Manual Mode allows you to choose only those set up choices that you
want to make without going through every possible choice of settings.

For example, if your test environment setup is similar to Figure 45 below:
two Connection by using W2641A Test Fixture, then your physical
connection for the data eye test should be similar to Figure 46.

DisplayPort -- DisplayPort 1
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DisplayFPort Test Emaronment Setup
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Connection T ype
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<< Back to Main Page

[ Hide Informative Test
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Figure 45 Setup for Data Eye Pattern Differential Tests (Two Connections with W2641A
DisplayPort Test Fixture)
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Figure 46 shows a physical connection for making single-ended

connections.

Infiniium Oscilloscope

®

ISI=TE) @@@

U7232A DisplayPort Compliance Testing Notes

SMA to SMP cables

Data Channel

Lane on the W2641A test fixture

Source AC Common Mode Noise Tests 13

DUT

Figure 46 Probing for Single-ended Tests - AC Common Mode Noise Tests (Two
Connections with W2641A DisplayPort Test Fixture)

You can use any of the oscilloscope channel and connect them to any of
the lane test points. You select the channels used for test a lane in the Set
Up tab of the DisplayPort Electrical Performance Compliance Test

Application.

The data lanes and channels shown in the previous figures are just
examples. You can choose any desired data lane and channel that you

want.
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13 Source AC Common Mode Noise Tests

AC Common Mode Noise Test

124

The AC common mode noise measurement of the distributed clock network
verifies that the nominal operating clock frequency is within the
Acceptable tolerance range. In order for sink devices to properly recover
the data, the source clock must operate within the Acceptable tolerance
range.

The test must be made at all bit rates supported by the device under test
without pre-emphasis and a voltage swing of 1.2 volts. A test pattern of
D10.2 should be used.

Test Procedure

1

Start the automated testing application as described in “Starting the
DisplayPort Electrical Performance Compliance Test Application" on
page 18.

Connect the W2641A test fixture to the device under test (DUT).

If you are using one connection, connect the probe to any channel. If
you are using two connections, connect the two probes to any two
channels of the oscilloscope. If you are using four connections, connect
the four probes to any four channels of the oscilloscope.

Connect the SMA to SMP cable to the SMA probe head of one of the
probes and to the data lane connector on the W2641A fixture that you
want to test.

Connect the other SMA to SMP cable to the other SMA probe head and
to the data lane on the W2641A test fixture that you want to test.

In the DisplayPort Compliance Test Application, click the Set Up tab.

Set the DUT Definition Driven Setting, the Test Type, the Fixture Type,
Lane- Channel Selection, Connection Settings, and the Connection Type
according to the type of testing being done.
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Navigate to the AC Common Mode group, and check the rise time and fall
time tests that you want to perform.

DisplayPort -- DisplayPort 1 * |Z”E”X|
File View Help
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Figure 47 Selecting Transition Time Differential Tests

8 Follow the DisplayPort Electrical Performance Compliance Test
Application’s task flow to set up configuration options (see Table 14),
make oscilloscope connections, run the tests, and view the tests results.
Options may vary depending on the selected mode: Compliance Mode or

Debug Mode.
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Table 14 Test Configuration Options

Configuration Option Description

Clock Recovery

Clock Recovery Order Set either a second order PLL or a first order PLL method is used to
recover the clock.

Clock Recovery Loop Sets the 3 dB bandwidth of the loop filter used by the PLL.
Bandwidth

Clock Recovery Damping  Sets the damping factor which is the value that is used in designing

Factor the second order PLL that is used to recover the clock. The damping
factor and the 3 dB bandwidth of the PLL are related to the natural
frequency using the following equation.

27‘CFt

J2c2—1+A/(2z;2-1)2+1

n

where:

®, = the natural frequency of the PLL

¢ = the dampling factor of the PLL
F, = the 3 dB bandwidth of the PLL

Prerequisite Settings

Bandwidth Reduction Specifies the bandwidth frequency for the oscilloscope. This
configuration is only available when the Enhanced Bandwidth or Noise
Reduction option is installed on the oscilloscope.

Vswing Edge Sets the number of Edges used when performing the Vswing
measurement. The Vswing value is used to ensure that the waveform
is displayed as large as possible in the waveform viewing area.
Increasing this value increases the test run time but improves the
repeatability of the measurement.

VTop & VBase Edge Sets the number of edges required when making the VTop and VBase
measurements.

VH Pattern (Debug only)  Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

VL Pattern (Debug only)  Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

PRBS Validation Algorithm Settings

FFT Memory Length Sets the memory depth used for FFT calculations.
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Table 14 Test Configuration Options

Configuration Option Description

FFT Acquisition

Eye Diagram

Eye Diagram Edge
Mask Scaling Option
Mask Type

Interpolation (Debug
only)

Eye Diagram Mask
Movement (Debug only)

Jitter Separation Settings

Jitter Separation Edges

Bit Error rate

Transition Time

Transition Edges

Transition VH Pattern
(Debug only)

Transition VL Pattern
(Debug only)

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Non-Pre-emphasis

Level Edges

Pre-empabhsis Level

Pre-emphasis Edge

Inter-pair Skew

Inter-pair Skew Edge

Maximum Retries

Sets the number of acquisitions used for FFT calculations.

Source Differential Tests

Sets the number of edges measured for the eye test.
Sets the type of scaling performed on the mask for the eye test.
Selects the type of mask to use for the eye test.

Specifies whether to turn On or Off the Sin(x)/x interpolation filter.
Turning On interpolation may cause more peak-to-peak jitter.

This field contains 4 options. (1) Find Passing Mode will automatically
search +/-0.5Ul horizontally until no violation occurs, (2) Fixed Mask
will not be moving, it only report Pass or Fail upon test, (3) Find Biggest
Margin will search +/-0.5U1 horizontally to find the maximum margin
of non-violation mask, (4) Manual mode will allow the user to move
the mask manually during the eye test,

Sets the number of edges measured for the jitter separation test.

Sets the bit error rate for the RJ/DJ measurements.

Sets the number of edges measured for the transition tests.

Sets the pattern that represents a high or one voltage when three or
more ones are transmitted in a row.

Sets the pattern that represents a low or zero voltage when three or
more zeros are transmitted in a row.

Sets the upper threshold for the transition tests in percentage.

Sets the lower threshold for the transition tests in percentage.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the level test.

Sets the number of edges measured for the inter-pair skew test.

Sets the number of times that the application tries to measure the
inter-pair skew test before failing.
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Table 14 Test Configuration Options

Configuration Option

Description

Spread Spectrum Clock (SSC)
SSC Acquisitions

Rise-Fall Mismatch
Rise-Fall Mismatch Edge

Upper Threshold (Debug
only)

Lower Threshold (Debug
only)

Intra-pair Skew
Intra-pair Edge

AC Common Mode
AC Common Edge

Sets the number of acquisitions taken to verify the SSC.

Single-ended Tests

Sets the number of edges measured for the rise-fall mismatch test.

Sets the upper threshold used to make a rise time or fall time
measurement.

Sets the lower threshold used to make a rise time or fall time
measurement.

Sets the number of edges measured for the intra-pair skew test.

Sets the number of edges measured for the AC common mode test.

PASS Condition

AC Common Mode Noise = Nominal Frequency *300 ppm.

Test References

See Test 3.10: AC Common Mode Noise, in the DisplayPort- Compliance
Test Specification Version 1.
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This chapter describes the Agilent Infiniium digital storage oscilloscope
calibration procedures.

Agilent Technologies
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14 cCalibrating the Infiniium Oscilloscope and Probe

Required Equipment for Calibration

To calibrate the Infiniium oscilloscope in preparation for running the
DisplayPort automated tests, you need the following equipment:

e Keyboard, qty = 1, (provided with the Agilent Infiniium oscilloscope).
e Mouse, qty = 1, (provided with the Agilent Infiniium oscilloscope).

¢ Precision 3.5 mm BNC to SMA male adapter, Agilent p/n 54855-67604,
qty = 2 (provided with the Agilent Infiniium oscilloscope).

e Calibration cable (provided with the Agilent Infiniium oscilloscopes).
e E2655A/B probe de-skew fixture.

e 82 Q damping resistors (01130-81506) for the Socketed Differential
Probe Head.

Figure 48 below shows a drawing of the above connector items.

@ ————— Precision 3.5 mm Adaptors (2)
P \

BNC Shorting Cap
(Used to calibrate

54854A and 54855A Calibration (_Iable

oscilloscopes) (Used to calibrate
54855A and 80000
Series

oscilloscopes)

BNC Calibration Cable
(Used to calibrate 54854A oscilloscope)

Figure 48 Accessories Provided with the Agilent Infiniium Oscilloscope
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Calibrating the Infiniium Oscilloscope and Probe 14

Internal Calibration

This will perform an internal diagnostic and calibration cycle for the
oscilloscope. For the Agilent oscilloscope, this is referred to as Calibration.
This Calibration will take about 20 minutes. Perform the following steps:

1 Set up the oscilloscope with the following steps:

a Connect the keyboard, mouse, and power cord to the rear of the
oscilloscope.

b If a second monitor is being used, connect it to the VGA connector
located near the LAN port, on the rear of the oscilloscope.

¢ Plug in the power cord.

d Turn on the oscilloscope by pressing the power button located on the
lower left of the front panel.

e Allow the oscilloscope to warm up at least 30 minutes prior to
starting the calibration procedure in step 2 below.

2 Locate and prepare the accessories that will be required for the
internal calibration

f Locate the calibration cable.
g Locate the two Agilent precision SMA/BNC adapters.

h Attach one SMA adapter to the other end of the calibration cable -
hand tighten snugly.

i Attach the other SMA adapter to the other end of the calibration
cable - hand tighten snugly.
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14 Calibrating the Infiniium Oscilloscope and Probe

3 Referring to Figure 49 below, perform the following steps:

a Click on the Utilities>Calibration menu to open the Calibration
window.

Setup Measure Analyze BEHEINIESN Help

Calibration...

20.0 GSafs 1.0@ kpts Self Test...

BCE
= v eGUL..

GPIB Setup...
Web Control...
LxI Lan Setup...

File Control

Install Licenses...

User Preferences...

EEEE

Figure 49 Accessing the Calibration Menu.

4 Referring to Figure 50 below, perform the following steps to start the
calibration:

a Uncheck the Cal Memory Protect checkbox.
b Click the Start button to begin the calibration.
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(e Calibration Status: Calibrated Cloze
Probe Comp v Calibration aTemp; -5
Calibration Date: 31 UL 2006 11:15:41 Help ﬂ
Time Scale Cal ATemp:  0°C

Time Scale Cal Date: 21 APR 2006 13:12:33

W Cal Memory Protect

Start

Calibration Status

Common Passed

Channel Vertical Trigger
i Passed Passed
2 Passed Passed
5 Passed Passed
4 Passed Passed

Al Passed

I~ Details

Probe calibration is accessed via the Channel Dialogs

Figure 50 Oscilloscope Calibration Window

5 Follow the on-screen instructions:

a You will be prompted to disconnect everything from all the inputs:
click the OK button.

b Then you will be prompted to connect the calibration cable with
SMA adapters between the Aux Out and a specified input. Install the
SMA adapter by pressing it on input BNC, and hand tightening the
outer ring turning right. Click the OK button after connecting the
cable as prompted.

¢ During the calibration of channel 1, you will be prompted a
Calibration Options screen, as shown in Figure 51 below.
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Standard Calibration Std

Standard Calibration + Time Scale Callbration. This requires an acourate 10MHz source, St + T
This should be performed once per vesr, me

Standard Calibration + Reset Time Scale Calibration to factory settings. Std + DIt

Help

Figure 51 Time Scale Calibration Dialog box

d Click on the Std + Dflt button to continue the calibration, using the
Factory default calibration factors.

e When the calibration procedure is complete, you will be prompted
with a Calibration Complete message window. Click the OK button to
close this window.

f Confirm that the Vertical and Trigger Calibration Status for all
Channels passed.

g Click the Close button to close the calibration window.
h The internal calibration is completed.
i Read NOTE below.

These steps do not need to be performed every time a test is run. However, if the ambient
temperature changes more than 5 degrees Celsius from the calibration temperature, this
calibration should be performed again. The delta between the calibration temperature and
the present operating temperature is shown in the Utilities>Calibration menu.
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Probe Calibration and De-skew

Before performing DisplayPort tests you should calibrate and de-skew the
probes.

SMA probe head Atten/Offset Calibration

1 Referring to Figure 52 below, perform the following steps:

a Ensure that a probe, attached with SMA probe head is connected to
Channel 1. Install the 82 Q resistors into the SMA probe head.
Connect the de-skew fixture to Aux Out. Clip the resistors on
de-skew fixture. These resistors are only required for probe
calibration and de-skew.

b Click on the Setup>Channel 1 menu to open the Channel Setup
window.

File Control Measure Analyze Utilities Help

1 Channel 1... k .
|
C EdChannel 2... - ", O
F | -~ @ -

p—— .Channel 3 —————————
.Channel 4...

Horizontal...

Trigger...
InfiniiScan...

Acquisition...
Display...

Waveform Memory...

EEEEEN

Figure 52 Channel Setup Window.

¢ Click the Probes button in the Channel Setup window, to open the
Probe Setup window.
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(X

Channel Setup

[ On

Scale
1.00 v/

2]

Jffset
0.0

[«»

Skewvy
00s 4/0/»

Labels Frobes.. [%
ron I j Trigger...

Figure 53 Channel Dialog Box
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2 Referring to Figure 54 below, perform the following steps:

Calibrating the Infiniium Oscilloscope and Probe

14

a Click the Add Head... button, and then select E2678A:DF Sckt from

the list of Head Type. Select OK to close the dialog box.

Probe Setup
Qe |@rorcbe  |@imn |@ropoe |
Configure Probing System | Calibrate Prabe. ..
Head Label (Type) 1134A Probe Amplifier

@: [Head1 (E2678A DF Sckt =] =

Add I—|ead[% Edit Head...

Serial #: LIS42002915
Bandwidth: 7.0 GHz

Celete Head | Delete ALL
Signal being probed

= Single-Ended

« Differential

Head1
Model: E2678A
Diff Socketed

Probe System

WAtten Cal: Calibrated
Skew Cal: Callbrated
IAttenuation:  10.1:1

Characteristics
Bandwidth: 7.0 GHz
Pesistance: 25.0 ko
Capacitance: 560.0 fF
Man Imput: £30.0 v
Dynirange: £2.5V

M range: £8.0 V

SE offset range: £12.0V

Close

Help

k?

Figure 54 Probe Setup Window.
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3 Referring to Figure 55 below, perform the following steps:

a Click on the Calibrate Probe button to open the Probe Calibration

window.
Probe Setup X
(1 FEE2N i'NoProbe @z | @rome |
Configure Probing System ‘ Calibrate Probe... s | Close
Help | &?
Head Label (Type) 1134A Probe Amplifier

®= [Headlt (E2678ADF Sckt ] i S8l #; USA2002915
Add Head... | Edit Head...

Celete Head | Delete ALL librati

(Calibration Status
\Atten Cal: Calibrated
Signal being probed Skew Cal: Calibrated

&~ Single-Ended IAtteruation:  10.1:1
" Differential
. teristi
1 Bandwidth: 7.0 GHz
odel: E2678A Resistance: 25.0 ka
iff Socketed (Capacitance: 560.0 fF

May input: £30.0 V
Dynirange: £2.5V
ICMrange: 8.0V

ISE offset range: £120 V

Figure 55 User Defined Probe Window.

4 Referring to Figure 56 and perform the following steps:
a Select the Calibrated Atten/Offset Radio Button

b Click the Start Atten/Offset Calibration Button to open the
Calibration window.
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(1 BEEXTS @ 1o probe \.1134,& ‘.NoProbe ‘

Please allow 15 minutes for probe Close

warmup before starting calibration, 4|

Attenuation/Offset Callbration Value, ~Skew Calibration Value Help | R?
© Default Atten/Offset « Default Skew
& Calibrated Atten/Offset " MNo Skew

Start Atten/Offset Calibration_H € Calibrated Skew

Head Label (Type) 1134A Probe Amplifier
|Head1 (E2678A:DF Skt v | |Attached Head: Head1 (E2678A:Diff Socketed)

Atten/Offset Calibration Status

Default Atten 10.0:1
Calibrated Atten 10.1:1 15 AUG 2006 11:46:12

Skew Calibration Status

Using default skew

Figure 56 Probe Calibration Window.

¢ Follow the on-screen instructions.

d At the end of the Atten/Offset Calibration perform the Skew
Calibration.

Differential Probe Head Skew Calibration
This procedure ensures that the timing skew errors between channels are
minimized. Perform the following steps:
1 Referring to Figure 57 below, perform the following steps:

a Select the Start Skew Calibration button and follow the on-screen
instructions. For more information on proper connection of probe to
the oscilloscope, refer to the De-skew and Calibration manual. This
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manual comes together with the E2655A/B De-skew Kit, that came

with your oscilloscope.

Probe Calibration

(1 JEETS

|eNOProbe

© Default Atten/Offsat
# Calibrated Atten/Offset

Please allow 15 minutes for probe
warmup before starting calibration.

Atteniation/Offset Callbration Value

| . 11344

|@noprobe |

Close
_reb | %]

Skew Callbration Value
" Default Skew

Mo Skew

Start Atteny/Offcet Calibration. .| | Callbrated Skew

Head Label (Type)
[Head1 (E2678A DF Sckt » |

Start Skew Callbration... Iy |

1134A Probe Amplifier
Attached Head: Headl (E2678A:Diff Socketed)

Atten/Offset Calibration Status

Default Atten
Calibrated Atter

10.0:1
0]

15 AUG 2006 11:46:12
Skew Calibration Status

Calibrated 15 ALIG 2006 11:46:54

X

Figure 57 De-skew Connection.

Each probe is calibrated to the oscilloscope channel to which it is connected. Do not switch
probes between channels or other oscilloscopes, or it will be necessary to calibrate them
again. It is recommended that the probes are labeled with the channel on which they were

calibrated.

SMA Probe Head Atten/Offset Calibration

1 Referring to Figure 58 below, perform the following steps:

a Connect the SMA to BNC adaptor to one of the SMA connectors of
the deskew fixture or SMA (f) to SMA (f) adapter.

b Connect the 50 ohm terminator to the center SMA connector of the

SMA probe head.

¢ Connect the other end of the deskew fixture or SMA (f) to SMA (f)
adapter to one of the SMA connectors of the SMA probe head.

d Connect the BNC connector of the SMA to BNC adaptor to the Aux
Out on the front panel of the Infiniium oscilloscope.

e Connect the positive (+) side of the InfiniiMax probe amp to the GPO
(SMP) connector of the SMA probe head whose path is connected to
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the Aux Out of the oscilloscope. Do not connect the negative (-) side
of the InfiniiMax probe amp to anything.

Figure 58 SMA Probe Head Calibration
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14 Calibrating the Infiniium Oscilloscope and Probe

f Click on the Setup>Channel 1 menu to open the Channel Setup
window.

File Control Measure Analyze Utilities Help

1 Channel 1... 't —
@ C
F

QChannel 2.
.Channel 3...
.Channel 4...

Horizontal...

Trigger...
InfiniiScan...

Acquisition...
Display...

Waveform Memory...

Figure 59 Channel Setup Window

g Click the Probes button in the Channel Setup window, to open the
Probe Setup window.
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(X

Channel Setup

[ On

Scale
1.00 v/

2]

Jffset
0.0

[«»

Skewvy
00s 4/0/»

Labels Frobes.. [%
ron I j Trigger...

Figure 60 Channel Dialog Box
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144

2 Referring to Figure 61 below, perform the following steps:

a Click the Add Head... button, and then select N5380A:DF SMA from

the list of Head Type. Select OK to close the dialog box.

Probe Setup [

Configure Probing Systemn I

(1 JSEEN @rorobe  [@rizaa | @ rison

Calibrate Probe. ..

®= Add Head... | Edit Head...

Delete Head | Delete ALL

Signal being probed
 Single-Ended
& Differential

dz
I: N5380A
iff SMA

= 1169A Probe Amplifier

Serial #: 1544001684
Bandwidth; 12.0 GHz

Probe System

Callbration S
WAtten Cal: Uncalibrated
Skew Cal: Uncalibrated
Attenuation:  2.1:1

Characteristics
Bandwidth: 12.0 GHz
Resistance: S0.00
Max input: £23V
Dynirange: £1.1V
CMrange: 4.3V

SE offset range: £2.3

Help | k?

Close

Figure 61 Probe Setup Window.

b Click on the Calibrate Probe button to open the Probe Calibration

window.

3 Referring to Figure 62 below, perform the following steps:

a Select the Calibrated Atten/Offset Radio Button

b Click the Start Atten/Offset Calibration Button to open the
Calibration window.
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Probe Calibration

Please allow 15 minutes for probe
warmup before starting calibration.

AttenuationfOffsat Callbration Value
© Default Atten/Offsat
~ Calibrated Atten/Offset

Start Atten/Offset Calibration. .. ‘

Calibrating the Infiniium Oscilloscope and Probe

(1 FREH |9Noprobe |@ 11348 | @ 1159

Skew Callbration Value
& Default Skew

T No Skew

© Calibrated Skew

Close

Help

%

Head Label (Type) 1169A Probe Amplifier
|Hea-:12 (N5380A:0F SMA ~| Attached Head: Head2 (N53B80A:Diff SMA)

Atten/Offset Calibration Status

Default Atten 2.4
Calibrated Atten  Not Callbrated (Using default values)

Skew Calibration Status

Mot Calibrated (Using default skew)

Figure 62 Probe Calibration Window.

¢ Follow the on-screen instructions.

d At the end of the Atten/Offset Calibration perform the Skew

Calibration.

SMA Probe Head Skew Calibration

This procedure ensures that the timing skew errors between channels are

minimized. Perform the following steps:

1 Referring to Figure 63 below, perform the following steps:

a Select the Start Skew Calibration button and follow the on-screen

14

instructions. For more information on proper connection of probe to
the oscilloscope, refer to the De-skew and Calibration manual. This
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manual comes together with the E2655A/B De-skew Kit, that came
with your oscilloscope.

X

Probe Calibration
(1 BN |°NoProbe [ FEe @ 1109 |
Please allow 15 minutes for probe Close I

warmup before starting calibration.
Afteniuation/Offset Callbration Value . - Skew Calibration Value Help | R?

~ Default Atten/Offset © Default Skew
& Calibrated Atten/Offset  No Skew
& Calibrated Skew

Stert Atteny/Offeet Callbration. .|

Start Skew Callbration. ..

Head Label (Type) 1169A Probe Amplifier
[Head2 (NS380ADF SMA ~| |Attached Head: Head2 (N5380A:DIff SMA)

\Atten/Offset Calibration Status

Default Atten 2.4l
Calibrated Attery Mot Callbrated (Using default values)

Skew Calibration Status
Mot Calibrated (Lising default skew)

Figure 63 De-skew Connection.
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U7232A DisplayPort Electrical Performance Compliance Test Application
Compliance Testing Notes

Figure 64 1169A InfiniiMax Probe Amplifier

Agilent recommends the N5380A SMA probe head and the N5380A
differential SMA probe head.

Figure 66 Recommended Socketed Probe Head for the DisplayPort Testing

Figure 66 Recommended SMA Probe Head for DisplayPort Testing
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15 InfiniiMax Probing

Table 15 Probe Head Characteristics

Probe Head Model Differential Measurement Single-Ended Measurement
Number (BW, input C, input R) (BW, input C, input R)

Differential socket E2678A 7 GHz, 0.34 pF, 50 kOhm 7 GHz, 0.56 pF, 25 kOhm

Hi-BW differential N5380A 12 GHz 12 GHz

SMA
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